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Getting Started 

 

The Web CMS (content management system) provides an easy way to build and update simple 

web pages for academic departments, centers and individual faculty here at Scottsdale 

Community College.  In addition, this software helps provide graphic continuity throughout the 

college website (see sample below).  A web page can contain both text and images and multiple 

pages can be created quickly, using special editing software which requires a login to access. 

 

Step 1: Open the “home page” for your department, center or individual faculty page. 

 Make sure the browser’s “pop-up blocker” is off.  From Internet Explorer, choose Tools 

>> Pop-up Blocker >> Turn Off Pop-up Blocker.  (You can edit the Pop-up Blocker 

Settings in that same menu to allow any pop-ups from the college’s website.) 

 
 

 If you have the Google or Yahoo toolbar installed in Internet Explorer, you may have to 

grant pop-up access to this site through that area as well. 

Step 2: Click on the dark blue copyright symbol (©) at the bottom of the web page in order to 

log in to the SCCWebGen editor.  The following window appears: 

Page link menu 

(navigate to other pages) 

Center area (displays 

currently selected page) 
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Step 3: Enter your username and password, then click   (or press Enter key). 

 This information is the same as your Netware network login (when you start up your 

computer). 

 

A special view of your home page appears, with editing buttons: 

 
 

From here, you can enter text and images to your home page, as well as create and link to other 

pages for your website.  These features are discussed in separate quick reference guides.  For 

example, go to the “Entering and Editing Text” guide next. 

  

Create new 
pages linked 
to home page 

Add (or edit content) for page currently 
selected from navigation menu 

Add 
link at 
page 

bottom 

Administrator 
use only 

Marketing 
department only 
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Entering and Editing Text 

 

Creating and modifying text for web pages is a very similar process to using a word processing 

program.  You can also check previous versions of a web page through the History feature. 

Step 1: If necessary, click on the link from the navigation menu to open the desired page. 

Step 2: Click  .  A separate Edit Content window appears. 

 

 The toolbars at the top of the window allow for WYSIWYG (What You See Is What You 

Get) creation of text and loading of pictures.  When you “hover” over a button, a short 

description appears (as in the above example for “Text Color”).  You’ll recognize many 

buttons from Microsoft Word’s standard and formatting toolbars. 

Step 3: When you are finished entering and formatting your text, click  .  You are 

returned to the web page, displaying the changes you made. 

 The college Marketing Department would like all pages on the SCC website to use Gill 

Sans MT font (or at least Helvetica), which is available from the pull-down Font menu. 

Copying from MS Word 

You can copy formatted text from Word into this software’s Edit Content window.  When you 

paste, you’ll receive the following prompt: 

 

Removes formatting 
from Word document Keeps formatting from 

Word document 
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Inserting a Hyperlink 

You can make a piece of text on your page a “clickable link” for the user.  This hyperlink can 

take the user to another web page or a file (e.g., Acrobat PDF file) uploaded to the web. 

Step 1: From the Edit Content window, highlight the text you want to make “clickable”. 

Step 2: From the top toolbar, click  .  The Link Manager window appears: 

 

Inserting an Email Hyperlink 

You can use the hyperlink feature to have the user go to an email message window, instead of 

another web page. 

 

Step 1: From the Edit Content window, highlight the name of the person you want to make 

“clickable”. 

Step 2: From the top toolbar, click  .  The Link Manager window appears. 

Step 3: In the Existing Page box, enter the email address, prefaced by “mailto”, as in the 

following example: 

Text you highlighted 
on page 

Indicate place you want user 
to jump to on same page 

Indicate place you want user to 
jump from on same page 

Link to 
existing URL 

See next section of this guide 
for information on creating a 

new page 

If you want the page to 
replace the home page 

text, then select No 

If you want the page to appear in 
a new browser window, then 

select Yes (this might be good if 
site is external to yours) 

Click upload file 

button for Acrobat 
PDF file, etc. 

Click to create the link 
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Step 4: Click .   You’ll see two warning message boxes: 

      
 

Step 5: Click  for both of these messages.  As with any hyperlink, you need to save 

to test the link. 

Linking to Existing Pages Properly 

When you are linking to an existing web page outside of your department, division, etc., it’s 

important to reference the link properly.   Web pages for different areas of the web are stored in 

different directories on the web server.  The following instructions discuss specifying the correct 

path to a web page. 

 

Step 1: From the Edit Content window, highlight the text you want to make “clickable”, then 

click    from the top toolbar to access the Link Manager. 

Step 2: In the Existing Page box, make sure you enter the correct path.  The following 

example makes sure that the frequently asked questions page for Counseling is found 

by the system.  You’ll note that the full “path” is not entered in the box. 

 

 To easily place the correct information in the box, you can open another instance of your 

web browser, then go to the page you want to link to.  In the Address box, highlight and 

copy the last part of the address (after the “.edu”), then paste it into the Link Manager 

window.  Note what’s highlighted in blue in the following example: 

 

Inserting a “Jump” Code 

In the Link Manager window you can create a “bookmark” link that allows the user to jump from 

part of a web page to another.  This is a two-step process: a) creating the bookmark; then b) 

linking to the bookmark. 

Step 1: Position the cursor where you want the user to jump to (e.g., the top of the page) then 

click   from the top toolbar. 
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Step 2: In the Link Manager window, enter the Text Displayed for Link name (e.g., “back to 

top”), then enter the bookmark name (e.g., “top”) in the Create Bookmark box.  

Step 3: Click .  An anchor symbol and the bookmark name appears. 

Step 4: Position the cursor where you the want the user to jump from, then   . 

Step 5: In the Link Manager window, enter the same Text Displayed for Link name you used 

above (e.g., “go to top”), then enter the bookmark name (e.g., “top”) in the Link to 

Bookmark box.   

Step 6: Click  .  The display name appears as a hyperlink.  Save the changes and test 

the link on the page. 

Working with Page History 

Step 1: From the Edit Content window, click  . The History window provides you 

with a list of versions of the page, with the most current version listed at top. 

 To return to a previous version of the page, click  , then  . 

 To modify a previous version, click  , then  . 

 To create a totally new version, click  .  A blank page appears. 

Modification Date 

Each time you save (publish) a page, the date and time are recorded and displayed in the bottom 

right corner of the template: 

 

 

Delaying Page Update 

In the Edit Content window, there is a text box at the bottom: 

 

By entering a date in this box (has to be at least one day in the future), then any changes you 

made in this editing session will not appear until the date you specified.  This also applies to a 

brand new page. 
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Creating a Table 

Tables are a useful way to structure information on a web page.  But they are a little tricky to 

edit, so try and plan it out in advance what you want in the table (number of rows, columns, etc.) 

to reduce editing later. 

To insert a new table: 

Step 1: From the Edit Content window, place the cursor where you want the table to start on 

the page. 

Step 2: From the top toolbar, click .  The following dialog box appears: 

 
 

Step 3: Make your selections then click  .  The table 

appears in the Edit Content window. 

To edit an existing table: 

Step 1: Place the cursor somewhere inside the table, then click  

 from the top toolbar.  The following list of options 

appears: 

Step 2: Choose the desired command. 

 

 A table from Word (or another web page) can be copied and 

pasted into the Edit Content window.  Just be careful to  

select the whole table. 

Determine the 
rows and columns 

needed in your 
table 

Add white space within 
table cells 

Change from left to center or right 

(only works if you decrease the 
Table Width down from 100%) 

Decrease number to 
narrow the table to 
less than width of 

Center Area 

Increase this 
number to display 
thicker table borders 
(insert “0” for not 
borders) 

Reveals a color palette 
for changing border color 

Reveals color 
palette for adding 
background color 

Upload an image 
which appears in each 

cell of table 
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Creating New Linked Pages 

 

You can create additional web pages which can be easily linked from your “home” page.  The 

link can be from a “navigation menu” on the left side of the screen or from the bottom of your 

home page. 

 

Creating a Menu of Linked Pages 

Step 1: Log into the Web CMS software. 

Step 2: From your home page, click  , located under the Welcome heading 

on the left side of the screen.  The Navigation Builder page appears: 

 
 

Step 3: Click  in the middle of the screen.  

 If you are on a page other than the home page (such as your syllabus), the button will say 

 .  This will create a new page under that page, as in this example: 
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The following window appears: 

 
 

Step 4: Enter the “link name” you want displayed in the navigation menu and determine if 

it’s an existing web page (you want to link to) or a new page.   

 It’s a good idea to keep a running list of these pages (names) for future reference. 

Step 5: Choose whether or not to open the page in a new browser window. 

Step 6: Click .  You are returned to the Navigation Builder page. 

Step 7: Click  .  Your home page reappears. 

Step 8: To open the new page, click on the link displaying in the navigation menu.  The title 

for the new page appears above the Edit Center Area button. 

 To enter text for the new page, check the “Entering & Editing Text” reference guide. 

 If you want to delete a page link, make sure you delete the text on that page first. 

Enter title of 
new page 

If page already exists, 
enter URL here 

If this is a new page, choose either “content” (navigation menu 
remains when clicked) or “content3” (no navigation menu) 

If you want the page to 
replace the home page 

text, then select No 

If you want the page to appear in 
a new browser window, then 

select Yes (this might be good if 
site is external to yours) 

You can place this new link before or 
after an existing link, by entering a 
different number (start with 1.00) 

Choose Yes to start a whole 
new section of links, (click ? for 
more info & see below) 

HTML filename 
based on the name 
you entered above 
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Working with a New Section of Links 

If you choose to have the page link start “a new section”, then the links you create for the new 

section replace the previous menu of links on the left side of the screen.  See the following 

example.  Note the difference between “Addendum”, which is a subpage off the main menu, and 

“Handouts”, which launches a whole new section of the site which replaces the main menu with 

new links. 

  

Using the “Breadcrumb Trail” 

When a user navigates around you website, the “breadcrumb trail” (located above “Welcome”) 

can be used to jump back quickly, such as to your home page by clicking on Home.   

 

 

 

You could, if you wish, create a page link in the left navigation menu that specifically returns the 

user to your home page. 

Creating a Link at a Page Bottom 

Step 1: From the desired page, click  . 

Step 2: Follow steps 3 – 6 in “Creating a Menu of Linked Pages” above.    

 You will have an additional option to  . 

The underlined link appears at the bottom of the current web page. 

 

  

Clicking on 
“Handouts” 
launches new 
section of links 

“Addendum” is a subpage of “Syllabus” on the main menu 

Use the breadcrumb 
trail to quickly jump 
back 
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Adding Images to Your Site 

 

In addition to entering text, you can also upload images to individual web pages.  You can also 

place an image in your page links navigation menu. 

 

Placing an Image in a Web Page 

Step 1: Open the page that will contain the picture. 

Step 2: Click  .  The Edit Content window appears. 

Step 3: Click  in the top toolbar.  The Revize Image Manager window appears. 

Step 4: Click  . Find and select the file, then click  .  The image 

appears, and the filename is listed in the Images folder: 

 
 

Uploaded file in 
“images” folder list 

Wrap with text on left or right, or 
text at top, middle or bottom 

Create border around 
image, based on point  

increments 

Spacing based on 
point increments 

Based on filename;  
edit if desired 
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 The college Marketing Department would like all images used on the SCC website to not 

have borders. 

Step 5: Make the necessary changes, then click in the Description box to verify the text. 

Step 6: Click   .  The image appears where your cursor was placed on the web page. 

 To move the image, point and drag on it.  To edit the image, click to select it, then click 

 . 

Placing an Image in the Page Links Navigation Menu 

Step 1: On any page, click  in the navigation menu on the left.  The 

Featured Image window appears: 

 

 As the “Note” describes, make sure the picture you want to load is relatively small.  You 

can use a program like Adobe Photoshop to resize the image before you bring it into this 

web editing software.  (Photoshop 7 is accessible through the Delivered Apps area in 

your Start menu). 

Step 2: Click  again.  The Revize Image Manager window appears. 

Step 3: Follow steps 4 – 5 above.  You are returned to the Feature Image window. 

Step 4: Click   to add the image to the navigation menu.  No matter which page 

you’re on, that image will appear. 

Turning an Image into a Hyperlink 

Step 1: Select the image that you wish to make “clickable.” 

Step 2: Click  .   

 Make sure you don’t change the name in the Text Displayed for Link box. 

Step 3: As with a text hyperlink, enter the necessary information and click Continue. 
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Editing Images with MS Photo Editor 

Using MS Photo Editor, you can resize your image before inserting it into a web page. 

Step 1: From the Start menu, choose All Programs. 

Step 2: From Delivered Apps, choose MS Photo Editor. 

Step 3: In Photo Editor, open the picture file (either from CD or somewhere on your 

computer). 

 To download a file from an email message: 

 From Web Mail, open the message, scroll to bottom of message, right-click on 

picture filename, choose Save Target As and choose location. 

 From Outlook, open the message, right-click on picture filename (near top), 

choose Save As and choose location. 

Step 4: From Image menu, choose Resize. 

Step 5:  For the Width, change the percentage (40-50%) and click OK. 

Step 6: From the File menu, choose Save as. 

Step 7:  Edit the filename, if necessary, and choose a location to save to, then click Save. 

Step 8: From File menu, choose Close. 

  Click the triangle for Save in box to choose a location, other than the current one. 

Step 9: Repeat steps 3 – 8 for other images to resize. 

Step 10: When finished resizing, exit MS Photo Editor. 
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Creating Acrobat PDF Files 

 

   

PDF (Portable Document Format) files can be created from many different programs, including 

Word, PowerPoint or Excel.  Because they are accessed through the free Adobe Acrobat Reader, 

which is installed on most computers, they are the most universal file type for students to print.  

Students will not need to have the specific application software on their computer to be able to 

print these files.  For that reason, they are ideal for posting to your Blackboard course web site.   

 

Fortunately, Microsoft Office 2007 has the capability to publish your files as PDFs.  On campus, 

this is automatically available within Word, Excel and PowerPoint.  Off campus, you’ll need to 

perform a one-time, free install first (go to this URL and follow the instructions: 

http://r.office.microsoft.com/r/rlidMSAddinPDFXPS.) 

Using the Built-in PDF Writer in Microsoft Office 2007 

Step 1: Open Word 2007, Excel 2007, PowerPoint 2007 or Access 2007. 

Step 2: From the Office button, point to (not click on) Save As. 

Step 2: From the Save As submenu, choose PDF or XPS. 

 XPS is a rival format to PDF and is not recommended, at this time. 

Step 3: Choose the location and revise the filename, as desired. 

 To customize the publishing of a PowerPoint PDF (e.g., as a handout), click Options. 

Step 4: Click Publish.  The file will appear in an Adobe Reader window for preview reasons. 

Creating a PDF File with Other Software Programs 

If the file was created in something other than Word 2007, Excel 2007 PowerPoint 2007 or 

Access 2007, use the following steps to “print” the PDF file. 

Step 1: Create, name and save your document as you normally would. (Be sure that all of 

your revisions have been made to the document before saving it.) 

Step 2: With the file open, from the File menu, choose Print.   

 For PowerPoint ONLY – From the Print what drop-down menu, select Handouts; from 

the Color/Grayscale, select Grayscale or B/W; from the Slides per Page, select 3 (this 

is the best format for handouts). 

Step 3: In the Printer Name field, from the drop-down menu, select Adobe PDFWriter, and 

click OK . 

 

http://r.office.microsoft.com/r/rlidMSAddinPDFXPS


12/07/07 Web CMS Workshop Guide 15 

 
 

Step 4: In the Save dialog window, select where you want to save the file (with the .pdf 

extension), and click Save.  This file is now ready to be uploaded into your 

Blackboard course.  

 

 PDF files cannot be edited without special software.  If you have to make any changes, 

make them to your original document, and save the revised file as a PDF file following 

the steps above.  

If you do not have Acrobat PDFWriter, you can download free PDF writer software for your 

Windows computer from: http://www.pdfmachine.com/pdfmachine/download.shtml . 

Students who do not have Adobe Acrobat Reader on their computer (there will be very few of 

these) can download it for free at:  http://www.adobe.com/products/acrobat/readstep2.html . 

Verifying Availability of PDF Writer 

Step 1: From the Windows Start menu, select Printers and Faxes.  

Step 2: If you don’t see Adobe PDF Writer listed, you will need to install it as follows: 

  From the Start menu, select All Programs > Delivered Apps > 

 Installs > Adobe PDF Writer XP 

  It will automatically install. 

  As prompted, restart your computer. 

 

 

http://www.pdfmachine.com/pdfmachine/download.shtml
http://www.adobe.com/products/acrobat/readstep2.html

